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OST to PST
Convert & restore large-sized OST files to PST, Exchange & Office 365.
    


    
EDB to PST
Convert EDB to PST file & migration to Exchange, Outlook, & Office 365.
 


    
Lotus Notes to Outlook
Converts Lotus/HCL Notes, Domino Server & SmartCloud to PST & Exchange.
   

	
    
MBOX to PST
Convert MBOX file of email clients to PST file & Office 365.
   

    

 
 
    
OLM to PST
Converts OLM to PST, Exchange Server, Gmail, Office 365, etc. in minutes.
    

	
    
EML to PST
Converts Multiple EML/EMLX files into PST & Office 365 cloud accounts.
    


    
Email to PDF Converter
Convert OST and PST files to PDF, EML, MSG and other email formats.
   



Explore all Email Converter Products   
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Exchange Recovery
Exports corrupted EDB files to Office 365, Exchange Server, PST, etc.
 


    
OST to PST
Saves orphaned OST files to PST, Exchange Server/Office 365 with ease.
 


    
Outlook PST Repair
Recovers inaccessible data from corrupt and damaged PST files with no data loss.
  


    
Exchange Suite
Full recovery solution for OST, PST, EDB & Exchange with smart filters.
 

	

 
  
    
Outlook Express Recovery
Recover inaccessible & lost DBX mail data with perfect folder hierarchy.
     

	

NSF Local Security Removal
Fixes access restriction issues of NSF databases with simple steps.
 





Explore all Email Recovery Products    
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SharePoint Migration
Easy SharePoint migration from File Servers, Public Folders & OneDrive.
    


    
Microsoft Teams Migration
Direct & simple Microsoft Teams Migration between Office 365 tenants.
   


    
Office 365 Migration
Efficient mailbox & public folder migration between Office 365 tenants.



    
OneDrive Migration
Migrates and backs up OneDrive for Business data & synced Drive folders.
    


    
Google Drive Migration
Migrate the entire Google Drive data along with metadata.
    


    
G Suite to Office 365
Migrates G Suite mailboxes and Google Groups to Office 365.
   

	

 
    
    
Exchange Migration
Intra-forest, cross-forest, hybrid, & cloud migrations in Exchange environments.
     


    
Import PST to Office 365
Imports PST/OST files to multiple mailboxes & Office 365/Exchange Groups.
   


    
Office 365 Migrator for Lotus Notes
Migrate Lotus Notes, HCL Notes/HCL Domino NSF files, & SmartCloud Notes mailboxes to Office 365.
   



Explore all Cloud Migration Products    
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Office 365 Backup & Restore
Backup Office 365/Exchange mailboxes to PST with total data security.
 


    
Export Office 365 to PST
Easily exports Office 365 mailboxes to PST, with many options.
 


    
G Suite Backup
Multiple G Suite mailbox backup to PST with inbuilt CSV file support.
  


    
IMAP Backup
Automated bulk IMAP mailbox backup to PST, EML, MSG, PDF, etc.
    


    
Zimbra Mailbox Backup
Robust tool to securely backup all Zimbra TBZ files while protecting their hierarchy & metadata.
    


    
Gmail Backup
Backup your Gmail data to PST & other formats with a full report in the end.
    

	

 

    
Exchange Backup & Restore
Backs up & restores on-premises, online & hosted Exchange mailboxes to PST.
   



Explore all Cloud Backup Products    
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Windows Data Recovery
Restores missing data from corrupt Windows systems & removable drives.
    


    
Video Repair
Repairs all video files with zero data loss irrespective of the file size & format.
    



Photo Repair
Repairs corrupted & damaged images/photos of all file formats with integrity.
 


    
Photo Recovery
Quick recovery of permanently deleted photos of JPG, BMP & other formats.
 

    

 
    

VHD Recovery
Complete solution for all types of VHD/VHDX corruption & data loss issues.
 


    
VMDK Recovery
Recovers all types of VMDK data files, providing easily customizable settings.
 



Linux Data Recovery
Restores Linux OS data from Red Hat, SUSE, Ubuntu, Turbo, Debian & SCO.
 



Explore all Data Recovery Products
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Outlook PST Repair
Repairs over-sized & corrupted PST files of any Outlook version.
 


    
Outlook Password Recovery
Easy Outlook PST password recovery even in case of multilingual passwords.
   


    
Outlook Duplicates Remover
Removes duplicate items from Outlook PST file by various criteria.
  


    
Merge PST
Join multiple Outlook PST files with advanced filtering options.
    

    

 
    
    
PST Splitter
Splits large Outlook PST files by various criteria, retaining mailbox integrity.
    


   
PST Converter
Unlimited conversion of Outlook emails to MSG, EML, MBOX, PST, HTML, etc.
   


    
PST Compress & Compact
Compress multiple PST files of any Outlook version with zero data loss.
 



Explore all Outlook Tools Products   
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Word Repair
Repair corrupt DOC, DOCX file and recover original text, fonts, etc.
  

	
    
Excel Repair
Repair excel spreadsheets including each cell, formulae, forms, cell comments, etc.
  

	
    
PowerPoint Repair
Recover complete PPT, PPTX, PPS file with text, images, graphics, audio, etc.
   


    
Access Repair
Repair highly corrupt MDB and ACCDB database files.
    

    

 
 
    
Publisher Recovery
Remove all corruption issues and errors associated with the Publisher files.
    

    

Explore MS Office File Repair  
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SQL Recovery
Recover corrupt, damaged, and deleted SQL-based MDF and NDF files.
  


    
SQLite Database Recovery
Recover the table, triggers, keys, and procedures in SQLite databases.
   


    
SharePoint Recovery
A wholesome recovery of corrupt SharePoint database MDF files.
    

	
    
Oracle Database Recovery
Restore the actual tables, views, clusters, etc. from Oracle databases.
  

   

 
 
    
MySQL Repair
Remove MySQL database’s corruption and extract precise data.
    

	
    
DBF Recovery
Repair corrupt DBF files created from various DBMS applications.
    


    
Access Repair
Remove all kinds of Access database file’s corruption and other issues.
    

    

Explore all Database Recovery Tools    
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PDF Repair
An instant removal of highly corrupt or damaged PDF files.
  

	
    
PDF Restriction Remover
Remove the local restrictions from multiple PDF files.
  

	
    
Image to PDF
Convert all kinds of image formats to the PDF format easily.
   


    
Split PDF
Split and merge multiple PDF files more accurately and safely.
    

    

 
 
    
PDF to Word
The simplest conversion from PDF to MS Word document files.
    

	
    
Word to PDF
Convert unlimited number of word document files to PDF format.
    



    

Explore all PDF Tools    
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Employee Monitoring
Monitor the live screens of unlimited workstations working in office/remotely.
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BKF Repair
Repair backup files created from all kinds of backup applications.
  

	
    
ZIP Repair
Recover large-sized ZIP files including all types of compressed data.
  

	
    
SQL Backup Recovery
Recover and review the corrupt SQL Backup files and utilize them again.
   


    
Tape Recovery
Repair data from DLP, AIT, LTO and DAT tape drives.
    

    

 
 

	


    

    

Explore all Backup Recovery Tools    

     










✕
    




View All Products ↠    



Professional Migration Services
Let our experts plan and execute your migration project from start to finish.

Cloud Migration Services    

    



	

	Solutions

	

Kernel Solutions by Platform DIY solutions for all the popular platforms    
	Office 365
	MS Outlook
	Exchange Server
	Google Workspace
	SharePoint
	Amazon WorkMail
	GroupWise
	SQL Server
	Lotus Notes
	See All Solutions

   

	

Kernel Suite Solutions for enterprise need
	1.Kernel Exchange Suite
	2.Kernel Outlook Suite
	3.Kernel Backup Suite
	4.Kernel Notes Conversion Suite
	See All Suite





Professional Migration Services
Let our experts plan and execute your migration project from start to finish.

Cloud Migration Services    
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Summary: Some PDFs are confidential, and for that reason, users protect them with a unique password. However, many users are not aware of the PDF owner’s password and how to remove it. So, this article will help you learn more about PDF owner passwords and methods to remove those passwords. If the manual methods cannot work, then there is some severe corruption in your PDF files. Eliminate those viruses with the help of the Kernel PDF Repair tool and repair and recover inaccessible PDFs seamlessly.  

We already know that PDF files are easy to read; the format doesn´t change after opening, and any operating system supports it. Most importantly, one can restrict their PDF file from copying and editing to prevent any misuse or mishandling of information by setting a password. A PDF file may be encrypted for security, or digitally signed for authentication. There are mainly two sorts of passwords – one to open the file or document, known as the “PDF User Password,” and the other password that limits printing and altering, known as the “PDF Owner Password.”

Customary PDF password security

The customary security provided by Acrobat PDF consists of two different methods and two different passwords – the user password, which encrypts the file and prevents opening, and the owner password, which specifies operations that should be restricted even after the document is decrypted, which can include printing, copying text/graphics out of the document, and modifying the document.

If your PDF file is protected with both types of passwords, it can be opened with either password. However, only the owner’s password allows the user to change the restricted features. Because of the added security, setting both types of passwords is often beneficial.

Please note: You cannot add passwords to a signed or certified document.

What is PDF user password or document open password?

In Adobe Acrobat, the User Password is known as document Open password, which encrypts the file. The owner’s password does not encrypt the file; instead, it relies on client software to respect these restrictions. An “owner password” can be removed by commonly available software or applications, including some free online services (which are not at all safe to use). Thus, the use restrictions that a document author places on a PDF document are not secure and cannot be assured once the file is distributed; this warning is displayed when applying such restrictions using Adobe Acrobat software to create or edit PDF files. You can also check out our free methods to unlock protected PDF files.

What Is PDF owner password or permission password?

In Adobe Acrobat PDF, the owner’s password is known as a Permission Password. A PDF owner password is a password that is used to restrict documents in PDF files. In Adobe Acrobat, the owner password is known as the change permissions password. Sometimes, it is also referred to as a restriction password, PDF permissions password, or PDF master password, depending on the PDF users.

PDF owner password gives the capability to protect your important files and control who interacts with them. This is what makes PDF the ideal format for business contracts and legal documents. It’s also perfect for securing your electronic diary! But when you need to share your files, sometimes you need to know how to unlock PDF as well.

Locking your PDF file using the owner’s password can help protect it, but it can also make it more difficult to distribute. Throughout this blog, we’ll be showing you what is PDF owner password is meant to be, as well as how to use it and unlock a PDF owner password to enable you to share your document.

Steps to setup the PDF owner password

In Adobe Acrobat, to protect PDF files or documents with a password, users need to follow the steps given below.

	Firstly, open the PDF document using Adobe Acrobat.
	Go to the Tools section on the menu bar.
	Click on the Protect symbol in the drop-down list of the Tools menu bar.
	Now go to the Encrypt section and choose Encrypt with password option.

In the Permissions window, check on the checkbox as per your requirement and then enter a password in “Check Permissions Passwords.” Users can also click on changes allowed to choose options from the dropdown.

	Check on the “Require a password to open the document” option and enter the password in the textbox. After that, click on the OK button.
	It further prompts you to save the PDF document or file to apply the security settings. Click on OK and press to save the PDF document.

How to set up Adobe Acrobat Advance Password Protection?

Open the PDF in Acrobat DC, and do one of the following:

	Choose Tools from the menu bar
	Click on Protect > More Options > Encrypt with Password.
	Choose File > Protect Using Password.
	Now choose Advanced Password Protection from More Options.

If you receive a prompt, click yes to change the security.

	Select Require a Password to Open the Document and then type the password in the corresponding field.
	Select an Acrobat version from the Compatibility drop-down menu. Choose a version equal to or lower than the recipients’ version of Acrobat or Reader.

It is always important to choose a version compatible with the recipient’s version of Acrobat or Reader because the Compatibility option the user chooses determines the type of encryption used.  For example, Acrobat 7 cannot open a PDF encrypted for Acrobat X and later.

	Acrobat 6.0 And Later (PDF 1.5) encrypts the document using 128-bit RC4.
	Acrobat 7.0 And Later (PDF 1.6) encrypts the document using the AES encryption algorithm with a 128-bit key.
	Acrobat X and Later (PDF 1.7) encrypt the document using 256-bit AES. To apply 256-bit AES encryption to documents created in Acrobat 8 and 9, select Acrobat X And Later.



	Select an encryption option from-
	Encrypt All Document Contents- Encrypts the document and the document metadata. If this option is selected, search engines cannot access the document metadata.
	Encrypt All Document Contents except Metadata- Encrypts the contents of a document but still allows search engines access to the document metadata.
	Encrypt Only File Attachments- Requires a password to open file attachments. Users can open the document without a password. Use this option to create security envelopes.



	Click OK. At the prompt to confirm the password, retype the appropriate password in the box and click OK.

How to remove password security in Adobe Acrobat?

Users can only get rid of security from an open PDF if they are allowed to do so by having permission. If the PDF is secured with a server-based security policy, then only the policy author or a server administrator is allowed to change it.

	Open the PDF in Adobe Acrobat.
	Select the Tools option from the menu bar.
	Click on Protect option from the drop-down menu.
	Click on More Options.
	Click on Remove Security.
	According to the type of password security of the document, the options may vary.
	If the document only has a Document Open password, click OK to remove it from the document.
	Enter a password if the document asks for a permission password and click the ok button. To confirm the action, click ok.





How to remove passwords from PDFs without using Adobe Acrobat?

If you forgot the PDF user password that you have used to password-protect PDF, then there is one Kernel for PDF Restriction Removal software to recover or remove the password altogether. You can try this advanced software, which smartly removes the PDF password and unlocks the PDF document without any damage to the content and structure of the file.

Free Download 100% Secure

The tool acts as a stand-alone utility that does not require Adobe Acrobat or Reader. The utility provides some amazing features as it works with PDF documents created by all versions of PDF creators. Also, offer a free trial version that removes PDF files up to 200 KB.

Summing Up

The above-discussed methods are reliable for removing PDF passwords. PDF files are known for their content confidentiality and security, so select the approach sensibly. We highly recommend starting using Kernel for PDF Restriction Removal because it doesn’t alter the structure, properties, and content of the PDF document. So there is no chance of data loss while removing the restrictions. It eliminates restrictions without disturbing the original formatting, structure, or properties of the PDF file. One can solve many issues like Ways to fix “Format Error: not a PDF or corrupted” or repair PDF files using such masterpiece software and applications.
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